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1  Introduction

The intention with this chapter is to give an introduction into LIB 500 BASE and LIB
510 functions. The functions are to some parts described in more detail.

Two separate phases can be identified:

1. Engineering phase, when configuring the application by means of the system tools.

2. The “runtime” phase, when the prepared and configured application is used and
connected to the process.

This Operator’s Manual does not deal with phase 1, focus is set on using the LIB 500
BASE and LIB 510 related functionality after a proper configuration.

However, as the user you may notice that all application areas and functionality
provided by LIB 500 BASE and LIB 510 described in this Operator’s Manual are not
covered by your application, because the functionality of individual applications is
designed according to the needs of the user. Or vice versa, your application may
feature functionality that is not described in the scope of this Operator’s Manual.

1.1 Reference documentation

Handling of LIB 500 is divided into two operator's manuals. For LIB 510 please see
LIB 510 4.0.3 Operator's Manual 1MRS 751281-MUM.

1.2 Safety Instruction

1.3 General about LIB 500 Base and LIB 510

LIB 500 BASE consists of basic functions needed for application handling (e.g.
backbone, user management, event and alarm list, busbar coloring). Furthermore, LIB
500 is the platform to which support packages are added to, e.g. LIB 510. LIB 510 is a
support package containing functionality such as MV process, procedures for
handling relays and terminals (SPACOM and RED), tools needed for configuring the
process terminals or for e.g. uploading of recordings from the disturbance recorders
etc.

It is strongly recommended to become familiar with the basic handling of
functionality in the application pictures and picture functions in order to avoid
situations that may cause danger to the personnel. Therefore, the use of
authorization levels is advisable, in order to allow only dedicated personnel to
perform control operations of e.g. switching devices.
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1.4 Application Pictures

Figure 1. Examples of application pictures

Figure 1 is composed of some examples of application pictures. In this case an alarm
list, trend report, harmonic violation period bars provided by the PQ-Monitoring Tool,
and a daily report from the Measurement Reports 2 are displayed.

Application pictures visualise the processes that are supervised. There are many
different types of application pictures; single line diagrams, process pictures, system
supervision, lists, application tools, measurement reports, and trend reports.

When a picture is presented on the screen, you first see the picture background. Then
the start program is executed. The start program may imply that windows are
displayed, contact is taken to the process database, the picture process objects are
given initial values etc. The start program cannot be interrupted by pressing any
function key.
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Generally, only one application picture is presented within the same monitor. Opening
another function closes or hides the previous one. However, several monitors can be
opened to the same application. Thereby the same application pictures or different
application picture can be shown in different places at the same time. If two or more
monitors are open to the same application processes and viewing/using the LIB 500
BASE and LIB 510 functions are settled by the user’s authorization level.

Your application may contain one or more application or process pictures, which can
be accessed from the pull down menus.

1.5 Process Picture (Station)

Figure 2 shows an example of a station (process) picture in a form of a single line
diagram. The MV processes can generally be shown in the process picture by
different representations, but the representation to be used is selected during the
picture configuration phase. Different colors are normally used for indicating status,
but also to indicate whether an object is connected to the process or not etc.

Figure 2. An example of processes in form of a single line diagram in a process picture (station picture)
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1.6 Picture Layout

1.6.1 Overview

Figure 3. Picture layout items

1. Application Name, Computer Name and User Name

2. Picture Header

3. Standard Menu Part

4. Picture Specific Menu Part

5. Help Menu Part

6. First Picture

7. Previous Picture

8. Date and Time

9. Picture Name
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10. Latest unacknowledged alarm

11. Day and Week

12. Shortcut buttons for Hard Copy, Event List, Audio Alarm Acknowledgement,
Alarm List

13. Station Symbol

14. Alarm Indication (blinking)

15. Picture Specific Area

16. Note Marker

17. Information Bar

18. ABB Logo

Table 1  Figure 3 can be divided into two sections

Section Remarks

Picture header Normally the same for different application pictures

Picture specific area Specific for the process viewed or the application picture
opened.

There are three types of pull-down menus:

Menu type Remarks

1 Standard Menu Part Contains standard menu functions, which normally
are the same within the application.

2 Picture Specific Menu Part Picture specific menu functions. The menus and
menu items are different from one application
picture to another, or not available in all pictures.
The Tools menu is a typical example.

3 Help Menu Part Contains system messages and representation
symbols.

The meaning of the notifications in Figure 3 is mostly self-evident, but the following
sections give further information regarding some items in Figure 3.

1.6.2 Alarm Indication

A red flashing alarm bullet  is presented at the right of the header bar when there
are unacknowledged alarms present in the system. Acknowledging of the alarm turns
the flashing red bullet into a red bullet with steady light, provided that there are more
alarms.

1.6.3 Alarm Row

Figure 4. Alarm row informing that there has been a trip due to overcurrent
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Below the header, an alarm row appears when an alarm is active. The alarm
indication, which provides information of the alarm, is displayed blinking until the
alarm is acknowledged or a new alarm is activated.

The alarm row gives the operator a quick notification of an alarming event in the
system. The advantage is not only that it can be noticed easily, it also instantly tells
the operator what has happened and where. With the alarm row the alarms can easily
be acknowledged.

The alarm row also contains other unacknowledged active and inactive alarms in the
system. The latest alarm is shown on the top of the list. Any of the alarms shown on
the list can be selected to be acknowledged.

The user’s authorization level has to be at least Control (1) before alarms can be
acknowledged. (The alarm row uses authorization group ALARM_HANDLING.)

On the alarm row, active and inactive alarms are separated by showing the alarm text
in parenthesis (Alarm) if the alarm is inactive. Thereafter, the date and time of the
alarm and the object text of the alarming object are presented.

1.6.4 Information Bar

Figure 5. The information above tells that the dialog for operating the breaker was
closed after a certain time of inactivity by the user.

The information bar located at the lowest part of the application picture informs about
e.g. ongoing processes or progress of the process, when no object specific dialog is
available.

The information bar also informs about possible SCIL status messages that might
occur. The Help pull down menu contains more information about the elapsed events,
and also a log book.

A new system message or SCIL status code replaces the previous one.

Information on the information bar is reset by clicking it with the mouse. The SCIL
status messages are still available from the HELP pull down menu.

1.6.5 Note Marker

The note marker  is used for writing notes, and it is also readable by other users.
The note marker is application picture specific, which means that when opening the
same view into another monitor, the same note marker is presented. As many note
markers as needed may be used. A note marker is opened by clicking it with the
mouse.
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1.7 Push Buttons in the Picture Layout

Push buttons in the picture layout are buttons that can be activated during run mode,
(click by mouse).

Figure 6. Picture layout push buttons

Push button
Number

Function Remarks

1 Shortcut to the first picture The first picture, shown after login

2 Shortcut to previous picture The previous picture opened.

3 Acknowledge Alarms Pops up when the alarm bar appears

4 Scroll in the Alarm List Scroll unacknowledged alarms

5 Shortcut to the Hard Copy A hard copy of the active
MicroSCADA window will be printed
out by clicking the hard copy button in
the upper right corner of the VS-
header

6 Shortcut to the Event List

7 Shortcut to the Audio Alarm
Acknowledgement

Audible alarms coming from a
MicroSCADA alarm unit will be
acknowledged by clicking the
Acknowledge audible alarms button
in the upper right corner of the VS-
header.

8 Shortcut to the Alarm List
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1.8 Pull-Down Menus in the Picture Header

Figure 7. Picture header pull down menus

This section describes the pull down menus, and some menu functions in more detail.
This section cannot predict all tailor-made pull-down menu configurations. Therefore,
the focus is set on the pull-down menus that are implemented in most cases.

Navigation between application pictures in the application is performed by using the
pull-down menus, and hence, direct access to all pictures/views in the system is
enabled.

Some menu items in the menus might be unavailable when some other view than the
main view is open, or the menu item has not been configured during the system
configuration. The menus can also be configured to contain other menu items than
described in this section. This section explains the basic menus and some optional
alternatives. The application may, however, contain several customised menus and
menu items.

LIB 500/510 based applications provide a hierarchical menu structure. This menu is
mainly common to all application pictures. Some of the menu items in the main menu,
e.g. the Event List, Alarm List, DR-Collector Tool, include an additional picture
specific Tools menu.

Pull-down menus Function

MAIN Login, Previous picture and End session are the default options.

OPTIONS Produces a menu with assistant pictures, e.g. user management,
trend basket and system tools

ENGINEERING Displays the tool manager, i.e. the menu to the engineering and
system handling tools.

REPORTS Provides various lists.

STATIONS Displays the station menu. Contents are Station authority and
configured station pictures, which also can be dedicated the
authentic names of the process to open.

SIMULATION This is an example of an additional menu that is added to the main
menu part. It enables simulating of processes and operations.

TOOLS The Tools menu is an example of an picture specific menu.

HELP System messages and representation symbols used for the process
pictures
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1.8.1 Standard Menu Part

1.8.1.1 Main Menu Functions

Figure 8. The Main pull down menu

Menu item Explanation

Login Used for login and logout for authorised users.

Previous Picture Takes the user back to previous picture.

End Session Ends the session and the monitor is closed.

Login Dialog

This Login dialog is started from the Main pull-down menu and by selecting LOGIN.
Another automatic login session is started when entering the system at start-up, while
this login is available when the application is already running.

The login dialog is for preventing unauthorised persons from making operations to the
actual process. The login determines the authorities of the user to be used in the
system.

Functionality

The user can insert a user name and a password to the fields and if the user is defined
and the password is correct, then the actual application is opened when login is
selected.

When the application is entered the very first time, the user logging in is made to be
the system manager. The system manager is the only user that can define other users
and their authorization levels. The system manager cannot be removed afterwards.
(NOTE! the user name may not include special characters and it may not contain two
letters followed by a number. The name may not begin with a number.) The login and
authorization mechanism can also be set out of use by the system manager.
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1.8.1.2 Options Menu Functions

Figure 9. The pull down Options menu

Menu item Explanation

Settings Menu item for change or view of Application owner, First
picture shown after login, Application logo picture, System
location, System name, Product info, Lockout duration,
Language settings, Daylight Saving time, Process control,
Show object ID, HD space alarm, Report Settings, Switch
device presentation.

User Management Menu item for change of a User’s profile, password or
adding/removing users.

Calendar Menu item that starts the calendar program. It is used for
defining features, activities or command procedures to be
performed on a certain day, or several.

Supervision Log The Supervision Log Viewer is used to monitor information
that has been collected by the System Self Supervision and
the NT operating system. These files contain information in
form of events coming from both hardware and software. For
more information, see LIB 500 Base 4.0.3 Operator’s Manual
(1MRS751278-MUM), System Self Supervision Operator’s
Manual.

Disturbance Recorder
Tools

This submenu contains the items DR-Collector Tool and
HV/Collect. DR-Collector Tool is a disturbance recorder tool
used in LIB 510/MicroSCADA, CAP 501, CAP 505, and in
SMS 510 environments. HV/Collect is used for disturbance
uploading function for high-voltage relays (LIB 520)

Trend Basket This menu item gives access to the basket function which is a
means of gathering objects for display in trends. The basket
function is described in a later chapter.

Note Marker Menu item for access to Note mark dialog for displaying and
writing notes. Five different colors can be selected.

1.8.1.3 Engineering Menu Functions

Figure 10. The Engineering pull down menu
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Menu item Explanation

DB Import/Export Exporting process objects from MicroSCADA database to a file.
Importing process objects from a file to MicroSCADA database

Busbar Coloring Shows the status of the busbar coloring. Busbar coloring can
also be stopped.

System Tools System tools used for configuring the applications and picture
functions, used when building the applications with its process
pictures.

The DB Import/Export function is described in a specific section in the chapter
Application related tools.

1.8.1.4 Reports Menu Functions

Figure 11. The Reports pull down menu

Menu item Explanation

Event List Opens the view to the Event List

Alarm List Opens the view to the Alarm List

Trend List Opens the view to the Trend List

Meas. Reports Opens the view to Measurements Reports 2

Blocking List Opens the view to the Blocking List

All the List functions in the table above are described in their respective manuals in
LIB 500 Base 4.0.3 and LIB 510 4.0.3 Operator’s and Configuration Manuals.
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1.8.1.5 Stations Menu Functions

Figure 12. The Stations pull down menu

Menu item Explanation

Station authority Defining control centers to control the picture

Show Measurement Provides an easy and a fast way to monitor the processes in the
picture.

Station 1 Opens the view to a defined process picture, unavailable until
configured

Station 2 Opens the view to a defined process picture, unavailable until
configured

The Stations menu can, of course, contain more than two stations, because this is
customer application dependent. Station 1 etc. is normally given a relevant name of
the station or process. Returning to the previous screen is done via the button
numbered 4 in Figure 3 or, depending on case, the first picture is brought into focus
by button number 3 in Figure 3.

1.8.1.6 Simulation Menu Functions

NOTE! The simulation menu is normally included only in the demo application.

Figure 13. The Simulations pull down menu

Menu item Explanation

According to configuration Simulations like overcurrent situations, auto-reclose
sequences, tripping of protections etc can be added

In this example the simulation menu is an additional menu of the main menu part.
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1.8.2 Picture Specific Menu Part

1.8.2.1 Tools Menu Functions

Figure 14. The Tools pull down menu as an example of a picture specific menu part

Menu item Explanation

Depending on the application
picture active.

The contents in the menu is related to the application
picture that is open. Trends, Alarm List, Event List,
Blocking List etc. all have their own list of menu items
in the Tools menu.

The Tools menu in Figure 14 is an example of a picture specific pull-down menu. The
Tools menu is available only when some picture has been selected, that is equipped
with a dedicated Tools menu. The contents in the Tools menu depends on which tool
is active (open). Therefore, there is no generic description of the contents in the Tools
menu, the contents is described with the tool concerned in the respective manual.

The Tools menu disappears when the application picture that opened the Tools menu
is closed.

1.8.3 Help Menu Part

1.8.3.1 Help Menu Functions

Figure 15. The Help pull down menu
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Menu option Explanation

System message Works as an aid for system engineering and debugging

Representation Selectable symbols for switching devices, protection trip and auto
reclosing

The Help menu consists of two parts; system messages and representations. The
system messages contain a list of messages given by the system. The representations
function shows a map over the used symbols for MV process objects and the meaning
of used colors.

The System Message dialog is made as an aid for system engineering and debugging.
When the dialog is opened, the dialog is updated with information of the SCIL status
codes occurred in the particularly picture. The list can be scrolled, if there are more
than one SCIL-status code message. The first or oldest status is shown first. If
additional statuses occur while the dialog is open, the dialog is refreshed by clicking
the Refresh button.

1.9 Process Lists

There are three types of process lists:

Number Type of list Explanation

1 Alarm list Presents the actual alarm state in the process data base

2 Event list Presents all events reported to the system

3 Blocking list Presents the blocking situation in the process data base.

Some typical blockings are alarm, event and control blocking. These lists are all
described in separate chapters.

1.10 Reports

Reports are used for analysing sampled measurements. The collected data can be
presented in a graphical or in a numerical form. Typical reports are energy reports,
currents, process disturbance reports (e.g. trippings, earth-faults, overcurrents, auto-
reclosures). These reports can be used for analysing fault situations, for improving
service and maintenance but also for normal supervision.

1.11 Tools

Tools are used in in order to provide the user with functions adapted to the system.
The tools are used for various needs; e.g. system engineering and maintenance,
configuration of relay terminals, uploading of disturbance recordings from
disturbance recorders etc. The tools are all described in separate sections/chapters.

Example of tools are:

• User Management

• Application Settings
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• Database Import/Export

• Login

• RED Relay Tool

• SPA Relay Tool for SPACOM

• DR Collector Tool

1.12 Application Window

An application window is a view or application or process picture that is shown when
running MicroSCADA. The application picture examples in section Application
pictures, Figure 1, are examples of application windows. Before the user has an
access to these application pictures, the user normally has to perform a login.

Normally, the login dialog pops up directly after system start-up. However, it could be
worth mentioning the three methods of getting to the stage of opening an application
window and the login sequence:

1 Automatic system start-up Turning on the PC and starting NT automatically
starts the MicroSCADA services and the login
dialog is shown.

2 Start-up icon The MicroSCADA session is started from an icon
on the PC desktop.

3 Manual start Manual start of the MicroSCADA services as well
as manual opening of a monitor.

Setting up the MicroSCADA system is described in the MicroSCADA installation
and System Configuration manuals. That is beyond the scope of this Operator’s
Manual since it is a question of a system configuration that has to be carried out
before starting to use the system on daily basis.

1.13 Opening an Application Window

The first picture displayed after an application window has been opened is an
application specific start picture. The start picture generally requires a user login (see
below) before the session can continue.

The EXIT button in the start picture and the ‘End Session/Yes’ in the End Session
Information dialog closes the application window. Use these buttons only when you
want to end the session.
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Figure 16. An example of the LIB 500 start picture with a login dialog

1. Application Name

2. Exit button to close the application window

1.13.1 User Login

In applications built with LIB 500, the start picture requests a user name and a
password. Each MicroSCADA user name is associated with a certain user profile
defined by the system manager.

The password is not displayed on the screen. If the user name and the password do not
match, or the user name does not exist, the start picture re-appears and you can make
a new attempt. Each attempt to log in is registered by the system (even attempts that
fail).

If the login succeeded, the first picture is produced on the screen. All operations
subsequently performed on the monitor or in the application window in question will
be related to the authority profile associated with the user name. The user name will
also be included as an identifier in the event register when certain manual operations
are performed.

A new login or a logout can be performed any time in the start picture and in the login
window which is accessed from the main menu.
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In order to prevent anybody else from using your user name and authority
profile, always logout or reset the authority level when leaving the control room.

1.13.2 Authorization

Each user name is associated with a certain user profile which may restrict the user’s
access to pictures or data. An additional dimension in the authorization mechanism is
that the objects in process pictures can be freely grouped into authorization groups.
This means that an user can have different authorization levels for different
apparatuses. Users can also be defined to have different authorization levels for
different substations etc.

Table 2  Applications built with LIB 500 provide the following four levels of user
authorities:

Authorization
level

Authorization
Group

Remarks

0 View The operator is allowed to view the functions but
not to make control operations.

1 Control The operator is allowed to make control
operations, e.g. control of switching devices
(limited rights).

2 Engineering All rights are granted, excluding user
management, which is dedicated to the system
manager (all rights).

5 System
Management

The user with this authority level is the system
manager. All rights are granted, including the
rights to add and remove users and authorization
groups. Each application has only one system
manager. The user that first logs into an
application will be the system manager of that
application.

If a standard function does not have an authorization group defined or the group is not
included in the authorization definitions, then an authorization level from the
predefined GENERAL group is used. Thus, the GENERAL group cannot be removed.

NOTE! System Tools are managed from an authorization group of their own called
Tools. This means that the authorization group TOOLS must be defined in order to be
able to dedicate the system tools to a certain user(s).

The system manager is the only one who is able to add and remove users and grant
rights to the users. The password, however, is selected and may be changed by the
user exclusively. This is done in the Change Password dialog.

The authorization level of the user will be reduced to the “View“ level when a certain
time (default = 8 hours) has elapsed since the last login.
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1.13.3 Closing

Logging Out

In LIB 500 based applications logging out means that the user name and user
authority are cleared. The user is logged out

• when the application is closed as described below

• when a new login is performed in the start picture or in the login window

• at emergency picture exit in X-monitor.

Time Based Logout

After a certain time has elapsed, e.g. 8 hours, an automatic logout is done. Logout
duration is defined in Application Settings Picture, i.e. the setting is application
spesific. The user has to login again via the Login dialog found in the Main menu.
The Main menu login is described earlier in the Main pull-down menu section.

Emergency Picture Exit

If you, for some reason, get into a locked situation where the Previous picture item
cannot be applied, you can always exit the operated picture by means of an invisible
function key, one character in size, in the upper left corner. This key is present on all
screens and application windows, independently of the displayed picture. In order to
use the emergency exit key:

• Click three times on the upper left corner.

First, on-going control commands in the picture are completed, though e.g. an on-
going data entry is interrupted. Then the picture is exited and the picture that is
defined as the first picture in your application is shown.

Depending on what kind of monitor that is used, emergency picture exit, returns to
different start pictures. When using VS local or VS Remote monitors, the first picture
after login is shown, while the X-monitor will show the login picture.

1.14 Shifting Pictures on Screen

Generally, shifting of picture functions on screen is obtained in any of the following
manners:

• By advancing through menus displayed on screen.(see Stations example in next
section)

• By selecting function keys in the picture functions.

The push buttons in the picture header is described in the section Push buttons in the
picture header, while the basic pull-down menus are described in the section Picture
header pull-down menus, all in this chapter. Picture function related menus and push
buttons are described with corresponding description of the picture function, e.g.
Event List, DR-Collector Tool etc.
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Switching between station pictures is done from the Station menu by selecting the
station to be opened. A station picture can be open on several monitors
simultaneously.

 This buttons opens the previously opened picture

 This button opens the first picture

1.14.1 Navigating in the Pull-Down Menus

The stations menu will be used as an example of how to access the menu items and
submenus provided by the pull-down menus. This example also shows how shifting
between process pictures is done.

Generally the menu items are functions or process pictures. A pull-down menu
contains one or several menu items.

The  after a menu item indicates that it is a cascade menu with more items.

The option that the mouse is pointing at or is the item selected is “lifted” compared to
the environment.

Step 1

Select the menu from the menu bar in the picture header.

Figure 17. Selecting the Stations menu item
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Step 2

Select a menu item in the pull-down menu.

Figure 18. Selecting the Eastwick 110/20 kV station, containing several process
picture, either in horizontal or in vertical form

Step 3

The items in the submenu are revealed, select with the mouse.

Figure 19. Selecting the 20 kV busbar item, which will be opened
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1.15 Basic Handling of Application Pictures

1.15.1 General

Figure 20. A picture containing folders, unavailable folder, selection buttons, and
push buttons

1. Available folders

2. Unavailable (disabled) folder

3. Selection buttons

4. Push buttons

The principles for handling the elements listed in Figure 20 are applicable to all
similar appearances regardless of the picture function.

In Figure 20 there are listed elements selected or activated by the mouse. When the
function is dimmed, it is unavailable.

1.15.2 Push Buttons

Figure 21. Examples of push buttons

In order to execute a push button:
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• Place the pointer on the button and click the left mouse button or press Enter on
the keyboard. A key can be recognised by the shadows around the key and by the
text attached upon the key.

The push button is activated when the button changes appearance and color so that it
seems to be pressed down. When a push button is activated, the program or the data
input of the button is executed from the beginning to the end. Meanwhile, no other
push button can be applied.

Some push buttons like More are containing more items, which are selected by
clicking on the desired menu item.

Figure 22. The More button is pressed

The More button contains various kind of functionality depending on from which
dialog it is opened.

Upon pressing a push button a verification dialog is opened for all operations that are
executing certain types of operation, e.g. opening a circuit breaker, raising of tap
changer position etc.. The user is there after asked to confirm the operation, thus
enabled to regret the operation. If the authorization of the user is not of enough high
level, the push button is dimmed, or not available. The push button may also be
unavailable or dimmed because of other ongoing processes or other conditions. Other
operations carried out upon pressing push buttons is e.g. that sub menus are opened or
directly starting another picture function etc.

Figure 23. Verifying the action to be performed
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1.15.3 Folder

Figure 24. The folder labelled Page 1 is selected and active

To select a folder, you just place the mouse on the folder e.g. Page 2 and click the
mouse button. The selected folder becomes active.

1.15.4 Selecting Options

Figure 25. Example of options with selection buttons

The options, both diamond and square, are also selected by the mouse. Press down the
option to be active or selected. If you want to deselect or change a selection, then you
have to press down an other option for the same setting, or in some cases another
click toggles the state like on/off. The options may already be selected due to
preconfigured or default settings. Depending on implementation one or several

options can be pressed down for the setting. Selecting
of options can also be done vertically or horizontally, depending on where it is
implemented.

Definitions and Examples

1a  is not pressed or selected

1b  means pressed down and selected.

2 One option may be more important than the rest:

Figure 26. Show on station picture is selected , which means that the two others can
be changed

Figure 27. Show on station picture is no longer selected, which means that the other
two are not in use, thus being unavailable.
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1.15.5 Scroll Folders Arrow Buttons

Figure 28. Scroll arrows for left and right direction

Clicking on a scroll folders arrow button scrolls the folders rightward or leftward
depending on the direction the arrow is pointing at. This function is used when the
folders are more than what is applicable in one view.

1.15.6 Entering Data

Text and data are entered in input fields which appear in the picture. The system
indicates with a horizontal blinking stroke or, in some cases, a vertical stroke, the
input cursor, that it is waiting for a data entry. If there is previously entered data in the
field, the character below the input cursor is flashing, and the text or data can be
edited.

Typical situations when data is to be entered is in the SPA Relay Tool and RED Relay
Tool for configuring relays and terminals, edit value limits dialog, for simulating off-
line process values, in Trends etc.

In order to enter data:

• If the input cursor is not visible, initiate the input by pressing the input field or the
input text.

• Type in the data using the keyboard or a soft key panel in the picture.

If the field contains previously entered data, a space or other character in the first
character position will empty the rest of the field. In order to edit, but not remove,
previous data, start by moving the input cursor.

• Complete the entry by pressing Enter on the keyboard. If the data entry comprises
several fields, an automatic activation of the following field is achieved by
pressing Enter or by clicking ENTER using a certain mouse button.

As long as the input cursor is seen, the system is waiting for additional data. As a rule,
no push buttons other than character keys, cursor positioning keys DEL,
BACKSPACE and ENTER can be applied. However, the emergency exit key can be
used, as well as certain push buttons (push buttons which perform the ENTER as the
first command). During data entry, all updating in the picture pauses.

The input fields are intended for either numerical data or texts.
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Figure 29. Edit limits, which is a typical function for the MV process

1.15.7 Moving Dialogs

Figure 30. Picture header items

Push buttons which are hidden under a dialog cannot be activated when they are
covered. Therefore, many dialogs are supplied with a feature for moving them from
one location to another. In order to move a dialog:

• Click the header of the dialog

• Hold down the left mouse key on the header of the dialog.

• Drag the dialog to the new location.

The dialog is now moved to the new location. However, the move is not permanent.
The dialog remains on its new location only as long as the picture is displayed on the
screen.
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1.15.8 Viewing HELP Texts

When there is a HELP button in the picture or in a dialog, help texts is accessed as
follows:

• Press the HELP button in the picture or in the dialog.

• Press the question mark symbol 

A dialog with information of the entire picture or function is shown. The HELP dialog
is closed by pressing CLOSE.

Figure 31. Showing help texts

Table 3  Explanations to the numbers in Figure 31:

Number in figure Meaning

1 Scroll arrow upwards

2 Sroll box

3 Sroll arrow downwards

1.15.9 Inquiring Picture Name

In order to view the name of the main picture currently shown on the screen or in the
application window:

• Click twice on the upper left corner.
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The picture name is shown in the upper left corner. You can remove the name by
clicking it.

1.16 Some Terms Used in the Operator’s Manual

Term Explanation

Application or customer
application

All the processes and views included in an application.
Normally an application consists of an overview or first
picture and several process pictures and application pictures.

Application picture An application picture is a picture giving you a quick overview
of the application, e.g. an Overview picture or a System
picture.

A station picture is a picture showing a specific station where
see the processes in the station.

A process picture is a picture showing a specific process is a
station.

In a very small application they can all be the same.

Attribute Attributes are containing the settings and definitions for the
properties for the picture functions and are stored in the
process data base.

Authorization Different users can have different access rights to the same
picture functions and processes.

Authorization level Different levels of authorization gives the users different
types of access, like view, control operations, system
manager etc.

Authorization group Picture functions and application pictures can be grouped
into authorization groups, thereby requiring a certain
authorization level of the user for e.g. control operations

Dialog A dialog is a two-way communication box between the user
and the system. The dialog informs the user about what is
happening, help texts, what can be done, which functions to
be executed etc. The user responds by selecting the
appropriate push button.

First picture The picture that is the first picture that is opened after the
login, also the one that push button 3 in Figure 3 opens.

Library function A library function is a function that with in a software package
is a ready made function that only need configuration of the
attributes.

LIB 500 LIB 500 contains the needed base functionality for installing
support packages like LIB 510, LIB 5xx... LIB 500 also
provides functionality like the Event list, Alarm list, Busbar
coloring etc.
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LIB 510 LIB 510 is a support package containing the library functions
for using e.g. MV process functions, Trend reports, SPA
Relay Tool, RED Relay Tool, DR-Collector Tool.

Monitor A monitor is the definition of the screen where the application
window is to be opened and the size of it, (12-15 or 16-20
size). The type of monitor is also determined, VS-Local, VS-
Remote or X-Monitor.

MicroSCADA session The whole operation from starting up the system, performing
login to running of the system with its customer application to
ending the session.

Menu item The available options that are listed when opening a pull-
down menu.

MFU Multi-function unit, such as relays, terminals etc.

MV Process Medium Voltage functions like Circuit breaker, Transformer,
Three state switch, Station, Bay etc. used as picture
functions in the process pictures.

Process data base A data base containing the individual process objects and
related attributes.

Process object A process object is some defined picture function like
disconnector

Process picture A type of an application picture containing process objects
(e.g. MV Process picture functions), which are connected to
the processes. In the process picture, e.g. measurements,
and the states of disconnectors and breakers are normally
updated, and switching devices can be operated.

Picture function The functionality is built in with the application picture
presented on the monitor. However, the application picture
can contain not only one or several different picture
functions, but also several similar ones, for example
disconnectors, transformers etc.

Representation symbol The symbol used for a picture function, e.g. circuit breaker,
transformer, measurement, relay etc. The representation
symbol is selected during the configuration of the picture
function.

Picture specific area An area where process specific functions are presented.

Push button Typical push buttons are buttons like OK, Cancel, Help,
More, Close etc. Upon pointing at the push button and then
clicking the (left) mouse button, the action behind the push
button is performed. Dialogs are typical providers of push
buttons.

Station picture A type of an application picture, which gives an overview of
the processes in a station. The station picture is often
designed according to a single line diagram, e.g. with MV
Process picture functions.

Switching device Devices in the MV process, that can be operated like circuit
breaker, three state switch, transformer etc.


